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Przegląd

Konstrukcja modułowa 
System Access Professional Edition (w dalszej części dokumentu
nazywany w skrócie Access PE) to kompleksowe, autonomiczne
rozwiązanie do kontroli dostępu dla firm małej i średniej
wielkości. Składa się ono z kilku modułów:
– Usługa LAC: proces, który polega na ciągłej komunikacji z

lokalnymi kontrolerami dostępu LAC (ang. Local Access
Controllers, w dalszej części dokumentu nazywanych
kontrolerami). AMC: modułowe kontrolery dostępu (ang.
Access Modular Controllers), które są stosowane jako
kontrolery.

– Configurator (Konfigurator)
– Personnel Management (Zarządzanie personelem)
– Log Viewer (Analiza dziennika)
– Alarm Management (Zarządzanie alarmami)
– Video Verification (Weryfikacja wideo)

Moduły serwera i klienta
Składniki te można podzielić na moduły instalowane i pracujące
na serwerze i na klientach.
Usługa LAC musi pozostawać w stałej łączności z kontrolerami,
ponieważ po pierwsze, stale otrzymuje od nich komunikaty o
ruchach, obecności i nieobecności użytkowników, po drugie,
przesyła do kontrolerów zmiany dotyczące danych, np. związane
z przyznaniem nowych kart, ale głównie dlatego, że
przeprowadza kontrole metapoziomowe (sekwencyjne kontrole
dostępu, kontrole funkcji zapobiegającej przekazaniu karty
osobie niepowołanej, kontrole losowe).
Aplikacja Configurator (Konfigurator) również powinna
pracować na serwerze, jednak można ją też zainstalować na
klienckich stacjach roboczych i obsługiwać z ich poziomu.
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Moduły Personnel Management (Zarządzanie personelem) i Log
Viewer (Analiza dziennika) należą do składników klienta i mogą
być uruchamiane dodatkowo na serwerze lub na innym
komputerze połączonym przez sieć z serwerem.
Istnieje możliwość zastosowania następujących kontrolerów:
– AMC2 4W (z czterema interfejsami czytników Wiegand) —

można rozszerzyć za pomocą modułu AMC2 4W-EXT
– AMC2 4R4 (z czterema interfejsami RS485 do czytników)
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Informacje ogólne

Wstęp
Access PE to system kontroli dostępu, który został
zaprojektowany z myślą o nadzorowaniu małych i dużych
obiektów o wysokich wymaganiach w zakresie bezpieczeństwa i
elastyczności.
Swą dużą niezawodność oraz możliwości w zakresie rozbudowy
Access PE zawdzięcza koncepcji trzech platform: nadrzędną
platformą jest platforma administracyjna wraz z usługami
kontrolnymi. Na tej płaszczyźnie wykonywane są wszystkie
zadania administracyjne, np. rejestracja nowych kart oraz
przydzielanie uprawnień dostępu.
Druga platforma tworzona jest przez lokalne kontrolery dostępu
(LAC) nadzorujące każdą grupę drzwi lub wejść. Nawet jeśli
system działa w trybie offline, kontroler LAC jest zdolny do
niezależnego podejmowania decyzji w zakresie kontroli dostępu.
Kontrolery LAC są odpowiedzialne za prawidłowy przebieg
procedur na przejściach, nadzorując np. czas otwarcia drzwi lub
pytając o kod PIN przy wejściach o znaczeniu krytycznym.
Trzecia platforma składa się z czytników kart.
Komunikacja między klientem, serwerem a posiadaczami kart
jest zaszyfrowana za pomocą mechanizmu AES.
Wersja wielostanowiskowa oprogramowania Access PE
umożliwia kontrolowanie systemu z różnych stanowisk.
Zróżnicowane poziomy uprawnień regulują dostęp
użytkowników do systemu i są gwarancją bezpieczeństwa.
Dlatego też np. na jednym stanowisku można zarządzać kartami,
a na innym skontrolować, czy dany pracownik jest obecny w
budynku.
System Access PE umożliwia niezwykle elastyczną konfigurację
uprawnień dostępu, modeli czasowych oraz parametrów wejść.
Poniższe zestawienie stanowi przegląd jego najważniejszych
funkcji:
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Szybkie i łatwe przydzielanie kart identyfikacyjnych
Przydzielenie karty (do trzech) danej osobie odbywa się poprzez
wprowadzenie danych ręcznie lub za pośrednictwem czytnika
cyfrowego, połączonego z komputerem za pomocą interfejsu
szeregowego. Wszystkie przypisane karty są aktywne. W
przypadku wymiany karty identyfikacyjnej stara karta zostaje
automatycznie zastąpiona nową i traci swoją ważność; dzięki
temu nie zdarzy się sytuacja, że stara karta, która przez
nieuwagę lub z powodu niemożności anulowania nie została
dezaktywowana, będzie nadal wykorzystywana.
Uprawnienia dostępu (również dla grup)
Jedna osoba może otrzymać zarówno uprawnienia grupowe, jak
i uprawnienia indywidualne. Uprawnienia można ograniczyć co
do obszaru jak i czasowo, z dokładnością co do minuty.
Uprawnienia grupowe można wykorzystać do przydzielania i
ograniczania uprawnień dostępu dla dowolnego posiadacza
identyfikatora lub dla wszystkich posiadaczy jednocześnie.
Uprawnienia grupowe mogą zostać uzależnione od modeli
czasowych, ograniczających ich działanie do wybranych godzin
w ciągu dnia.
Śledzenie dostępu
Dzięki definiowaniu stref można nadzorować i wymuszać
prawidłową kolejność przejść. Nawet bez monitorowania, za
pomocą tej konfiguracji można wyświetlić miejsce przebywania
posiadacza karty.
Funkcja zapobiegająca przekazaniu karty osobie niepowołanej
Jeśli dana karta została odczytana, wówczas przez określony
czas nie może być ponownie użyta w tym samym przejściu.
Dzięki temu użytkownik po przejściu bramki nie będzie mógł
przekazać swojej karty nieuprawnionej osobie, umożliwiając w
ten sposób niedozwolone przejście.
Automatyczna blokada kart po upływie terminu ważności
Goście oraz pracownicy tymczasowi często wymagają dostępu
tylko przez ograniczony czas.
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Wystawiając kartę można określić jej okres ważności. Po upływie
terminu karta automatycznie traci ważność.
Modele czasowe i modele dzienne
Każdej osobie można przydzielić modele czasowe, które
decydują o tym, w jakim czasie wstęp jest dozwolony. Modele
czasowe można zdefiniować elastycznie, przydzielając modele
dzienne określające, które dni tygodnia, weekendy, dni
świąteczne i dni specjalne różnią się od dni normalnych.
Identyfikacja na podstawie kodu PIN
Zamiast karty można używać specjalnego kodu PIN, który należy
wprowadzić.
Weryfikacja za pomocą kodu PIN
Dla obszarów ściśle chronionych można zdefiniować
konieczność wprowadzenia dodatkowych kodów PIN. Funkcję tą
można także połączyć z modelami czasowymi, np. aby podanie
kodu PIN wymagane było wyłącznie poza godzinami pracy lub w
dni wolne.
Elastyczne zarządzanie drzwiami
Elastyczne przydzielanie parametrów do poszczególnych modeli
drzwi zapewnia optymalną równowagę między bezpieczeństwem
i komfortem. Dla każdego wejścia można zdefiniować czas
otwarcia, zanim alarm zostanie uruchomiony. Wbudowana
instalacja alarmowa może, opcjonalnie, zablokować przejście.
Okresowe otwarcie drzwi
Dla ułatwienia dostępu wybrane drzwi można na określony czas
ustawić w trybie stałego zezwolenia. Takie zezwolenie może być
przydzielone ręcznie lub automatycznie za pośrednictwem
modelu czasowego.
Czas i udział
Punktom dostępu można przyporządkować parametry zapisu
czasu wejścia oraz wyjścia pracowników w celu kontroli czasu
pracy.
Tworzenie karty
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Dzięki dodatkowemu modułowi o nazwie Personalizacja kart
(CP) system kontroli dostępu zintegrowano z oprogramowaniem
do wystawiania kart identyfikacyjnych, co umożliwia operatorowi
tworzenie takich kart bez przełączania się do innych aplikacji.
Przypisywanie zdjęć
Jeśli moduł dodatkowy Personalizacja kart (CP) nie został
aktywowany, nie można importować i przypisywać identyfikatora
fotograficznego do posiadacza karty.
System blokowania offline
Strefy nieobjęte, z jakiegokolwiek powodu, systemem kontroli
dostępu online o wysokiej dostępności mogą być blokowane w
trybie offline.
Zarządzanie urządzeniami wizyjnymi
Wejścia można dodatkowo wyposażyć w kamery do identyfikacji
i śledzenia ruchów osób, które z tych wejść korzystają.
 

Logowanie użytkownika
Dostępne są poniższe aplikacje. Szczegółowe informacje na ich
temat można znaleźć w poszczególnych instrukcjach obsługi:

Zarządzanie personelem

Konfigurator

Analiza dziennika

2.2
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Zarządzanie mapami i alarmami

Weryfikacja wideo

Uwaga!

Logowanie przez klienta możliwe jest tylko, gdy na serwerze

aktywna jest licencja LAC.

Logowanie klienta
Aplikacje systemu są chronione przed nieuprawnionym użyciem.
Domyślne dane uwierzytelniające, które służą do pierwszego
uruchomienia:
– Nazwa użytkownika: bosch
– Hasło: bosch

Po wpisaniu prawidłowych danych w polach Nazwa
użytkownika/Hasło, uaktywniony zostanie przycisk Zmień hasło.
Po 3 nieudanych próbach, dostęp do systemu zostanie na
pewien czas ograniczony. Dotyczy to przycisków „Uruchom
aplikację” oraz „Zmień hasło”.
Na górnej liście rozwijanej można wybrać odpowiedni język.
Domyślnie stosowany jest język wybrany podczas instalowania
aplikacji. W przypadku zmiany użytkownika bez restartowania
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aplikacji zachowany zostanie ostatnio używany język. Z tego
powodu okno logowania może się wyświetlić się w
nieprawidłowym języku. Aby tego uniknąć, należy ponownie
zalogować się w systemie Access PE.
Aplikacje systemu Access PE można uruchomiać w
następujących językach:
– angielski,
– niemiecki,
– francuski,
– japoński,
– rosyjski,
– polski,
– chiński (ChRL),
– niderlandzki,
– hiszpański,
– portugalski (Brazylia).

Uwaga!

Wszystkie ustawienia, tj. nazwy urządzeń, etykiety, modele oraz

uprawnienia, będą wyświetlane w języku, w którym zostały

wprowadzone. Również przyciski i etykiety obsługiwane przez

system operacyjny będą wyświetlane w języku instalacji

systemu.

Po kliknięciu przycisku Zmień hasło wpisz nową nazwę
użytkownika i hasło w oknie dialogowym:
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Uwaga!

Należy pamiętać, aby zmienić domyślne hasło!

Z kolei użycie przycisku Uruchom aplikację powoduje
skontrolowanie uprawnień użytkownika i ewentualne
uruchomienie aplikacji. Jeśli kontrola uprawnień wypadnie
negatywnie, pojawi się komunikat o błędzie Wrong username or
password! (Nieprawidłowa nazwa użytkownika lub hasło!).
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Układ okna dialogowego Log Viewer
(Analiza dziennika)

1 = Pasek menu — zawiera funkcje okna dialogowego
dostępne w poszczególnych menu.

2 = Pasek narzędzi — zawiera najważniejsze funkcje okna
dialogowego w formie przycisków.

3 = Pasek tytułu — odpowiada standardowi systemu
Windows i zawiera przyciski do minimalizacji oraz
zamykania okna dialogowego. W nawiasach
kwadratowych wyświetlana jest nazwa zalogowanego
użytkownika.

4 = Stan urządzenia — lista skonfigurowanych urządzeń i
wejść oraz ich stan połączenia.

5 = Lista komunikatów — lista zgłoszonych komunikatów.
Wskazanie może być ograniczone przez niektóre
ustawienia filtrów.

6 = Wybór filtra — lista wyboru, która zawiera
zdefiniowane i dostosowane filtry, umożliwiając ich
ustawianie.

2.3

Access Professional
Edition

Informacje ogólne | pl 13

Bosch Access Systems GmbH 2017-08 | APE-UL | Log Viewer



7 = Aktywacja alarmu — umożliwia aktywację/
dezaktywację alarmu dla komunikatów. Pojawieniu
się komunikatu może dodatkowo towarzyszyć sygnał
akustyczny.

8 = Pasek stanu — informacje o datach otwartych
dzienników. Stan usługi LAC. Ustawienia alarmu.

Przyciski w postaci ikon
Następujące funkcje do analizy dziennika dostępne są w menu
oraz przyciskach na pasku narzędzi.

Menu Funkcja Przycisk Opis

Plik Drukuj… Drukowanie
wyświetlonych
komunikatów
dziennika.

Zakończ  Zamyka okno
dialogowe analizy
dziennika.

Filtr Definicja
filtra

Otwiera okno
dialogowe filtrowania
komunikatów.

2.4
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Menu Funkcja Przycisk Opis

Pokazuj
komunikaty
na bieżąco

Aktywuje bieżące
wskazanie aktualnych
komunikatów.
Przycisk ten jest
aktywny tylko wtedy,
gdy funkcja nie jest
włączona, a filtr
komunikatu obejmuje
aktualny dzień.
Domyślnym
ustawieniem jest
bieżące wskazanie
aktualnych
komunikatów.

Wyłącz
wskazywan
ie
komunikató
w na
bieżąco

Przerywa bieżące
wskazanie aktualnych
komunikatów.
Przycisk ten jest
aktywny tylko wtedy,
gdy włączone jest
wskazywanie
komunikatów na
bieżąco.

Komunikaty
poprzednie
go dnia

Przejście do
komunikatów z dnia
poprzedniego.

Komunikaty
następnego
dnia

Przejście do
komunikatów z dnia
następnego.
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Menu Funkcja Przycisk Opis

Widok Pasek
narzędzi

 Ukrywa/wyświetla
pasek narzędzi.
Wartość domyślna =
włączony

Pasek
stanu

 Ukrywa/wyświetla
pasek stanu.
Wartość domyślna =
włączony

bez pozycji z menu

   

   

? Pomoc Tematy
pomocy

Otwiera ten plik
pomocy.

Informacje
o Analizie
dziennika

 Otwiera okno
informacji o aplikacji
Informacje o Analizie
dziennika.

16 pl | Informacje ogólne
Access Professional

Edition

2017-08 | APE-UL | Log Viewer Bosch Access Systems GmbH



Dziennik
Wszystkie procesy (w tym np. dane dotyczące logowania i
wylogowywania użytkowników stacji roboczych) w systemie
kontroli dostępu Access PE są przekazywane za pomocą
odpowiednich komunikatów i przechowywane w dziennikach
zdarzeń. Poprzez klasyfikację można oddzielić komunikaty
związane z bezpieczeństwem (komunikaty alarmowe) od tych
czysto informacyjnych. Ułatwia to wprowadzanie kolejnych
funkcji, które mogą być niezbędne.
W celu zapewnienia przejrzystej prezentacji z opcją filtrowania
ważnych komunikatów i ostrzegania użytkowników
interaktywnych można zainstalować i uruchomić okno dialogowe
Logviewer (Analiza dziennika) na dowolnej stacji roboczej, o ile
pozwalają na to uprawnienia zalogowanej osoby.
 

Lista komunikatów
Główną funkcją aplikacji LogViewer (Analiza dziennika) jest
wyświetlanie komunikatów dziennika, zarówno nowych jak i
starszych.

Domyślnie wyświetlanie jest w sposób ciągły aktualizowane
przychodzącymi komunikatami. Odpowiednie przyciski na pasku
narzędzi mają następujące stany: .

3
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W momencie uruchomienia aplikacji LogViewer (Analiza
dziennika) wyświetlane są komunikaty z bieżącego dnia.
Komunikaty z poprzednich dni można wyświetlić za pomocą

przycisku . Każdego dnia tworzony jest plik dziennika o
nazwie Msg<rrrrmmdd>.log, zapisywany w katalogu: C:\BOSCH
\Access Professional Edition\Data\MsgLog. Wszystkie te pliki
można wyświetlać w aplikacji LogViewer (Analiza dziennika).
Lista komunikatów zawiera kolumny z następującymi
informacjami:

Kolumna Opis

(bez nazwy) Przedstawiona w formie symbolu
kategoria komunikatu, zdefiniowana
uprzednio w aplikacji Configurator
(Konfigurator).

(bez nazwy) Identyfikacja komunikatów, dla których
istnieje nagranie wideo: 

Date (Data) Data i godzina wygenerowania
komunikatu.

LAC/PC Źródło komunikatu: nazwa kontrolera
lub stacji roboczej.

Reader/Login
(Czytnik/Logowanie)

Źródło komunikatu, jeśli kontroler pełni
tylko funkcję przekaźnika. Jeśli źródłem
jest stacja robocza, wówczas jest to
nazwa użytkownika stacji roboczej.

Location (Door)/
Program
(Lokalizacja (drzwi)/
Program)

Określenie wejścia, sygnału lub innej
instalacji. Jeśli jest to stacja robocza,
wówczas jest to nazwa aplikacji.
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Kolumna Opis

No. (Nr) Numer komunikatu zgodnie z listą
tekstów w dzienniku zdarzeń w
aplikacji Configurator (Konfigurator).

Message
(Komunikat)

Tekst komunikatu, który zdefiniowano
w aplikacji Configurator (Konfigurator).

Card-No. (Numer
karty)

Nr karty identyfikacyjnej, jeśli jest
możliwa do odczytu i system ją
rozpoznaje.

Last name
(Nazwisko)

Nazwisko posiadacza karty
identyfikacyjnej.

First name (Imię) Imię posiadacza karty identyfikacyjnej.

Company/Dept.
(Firma/Dział)

Firma/Dział posiadacza karty
identyfikacyjnej.

Local date (Lokalna
data)

Jeśli kontroler AMC znajduje się w innej
strefie czasowej, w tym miejscu jest
pokazywany lokalny czas utworzenia
komunikatu.

Widok listy komunikatów można skonfigurować według potrzeb.
Można np. zmienić kolejność kolumn, przeciągając i upuszczając
nagłówki kolumn. W ten sposób kolumny uważane za mające
większe znaczenie można umieścić na początku.
Aby przyspieszyć znajdowanie określonych komunikatów, można
je posortować w widoku listy (ustawiając je w kolejności
rosnącej lub malejącej) przez dwukrotne kliknięcie nagłówka
kolumny.
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Uwaga!

W zależności od uprawnień użytkownika wyświetlanie

komunikatów może być mniej lub bardziej ograniczone. W

przypadku użytkowników, którzy mają prawo do wyświetlania

wyłącznie własnych komunikatów, wszystkie komunikaty innych

osób są odfiltrowywane. W przypadku użytkowników, którzy nie

mają prawa do wyświetlania żadnych danych osobowych,

ostatnie cztery kolumny są puste.

 

Filtrowanie komunikatów
Aby ograniczyć wyświetlanie komunikatów do tych, które
spełniają określone kryteria, kliknij pozycję Filter > Filter

Definition (Filtr > Definicja filtra) lub ikonę  na pasku
narzędzi. Zostanie otwarte okno dialogowe wyboru kryteriów
filtra.

 

3.2
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Komunikaty można filtrować według następujących kryteriów:
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Kryterium
filtrowania

Opis Notes (Uwagi)

Time period
from ... to...
(Okres czasu
od... do...)

Wprowadzając w tym
miejscu daty, można
ograniczyć
wyświetlane dane do
określonego
przedziału czasu.
Jako ostatnią datę
można podać datę
bieżącą.
Wprowadzając inne
daty przeszłych
zdarzeń, można
zmienić lub
rozszerzyć zakres już
wyświetlanych
danych.

Okres analizy nie
może być zbyt
długi, ponieważ
wszystkie dzienniki
muszą najpierw
zostać odczytane.
Zależnie od
rozmiaru dziennika
maksymalny okres
analizy nie
powinien być
dłuższy niż jeden
miesiąc.

Name (Imię i
nazwisko)

Wyświetlane są tylko
te osoby, których
imiona i nazwiska
odpowiadają
kryteriom filtra.

W przypadku
filtrów Name (Imię
i nazwisko),
Company/Dept.
(Firma/Dział) oraz
card (karta) można
wprowadzić dane
każdorazowo tylko
dla jednego
kryterium.

Company/Dept.
(Firma/Dział)

Wyświetlane są tylko
osoby z określonej
firmy lub działu.

card (karta) Wyświetlane są tylko
osoby o numerach
kart z określonego
zakresu. Np.
wszystkie numery
kart zaczynające się
od 6.
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Kryterium
filtrowania

Opis Notes (Uwagi)

Entrances
(Wejścia)

Wyświetlane są tylko
komunikaty
dotyczące
określonych wejść.

 

Messages
(Komunikaty)

Wyświetlane są tylko
komunikaty
określonego typu.

 

Alarm siren
with .wav file
(Syrena
alarmowa z
plikiem .wav)

Komunikatom
alarmowym może
dodatkowo
towarzyszyć wybrany
sygnał akustyczny.
Można wybrać
dowolny systemowy
plik audio.

 

Uwaga!

Filtr jest aktywny, dopóki działa aplikacja. Zamknięcie i

ponowne uruchomienie aplikacji LogViewer (Analiza dziennika)

powoduje przywrócenie ustawień domyślnych (tj. bieżący dzień,

bez filtrowania).

 

Zapisywanie i wczytywanie filtrów
Aby uniknąć ciągłego wprowadzania od nowa tego samego
wyboru, każdy użytkownik może zapisać swoje indywidualne
ustawienia filtra i wczytywać je przy uruchamianiu aplikacji
LogViewer (Analiza dziennika).
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Po utworzeniu osobistych ustawień filtra można je zapisać,
klikając przycisk Save... (Zapisz...) w dolnej części okna
dialogowego Domyślnie nazwane ustawienia filtra
(<nazwapliku>.flt) są zapisywane w katalogu C:\BOSCH\Access
Professional Edition\Data\Cfg

Zapisane ustawienia filtra można wczytać i aktywować przez
wybranie ich w polu kombi Filter (Filtr) w lewym dolnym
narożniku.
Aby sprawdzić i/lub zmodyfikować uprzednio zdefiniowane filtry,

należy je najpierw wczytać i otworzyć, klikając ikonę , a
następnie przycisk Load... (Wczytaj...) w oknie dialogowym
Filter view (Widok filtra).

Wczytane ustawienia filtra można następnie zweryfikować,
zmodyfikować i wreszcie zastosować do działającej aplikacji,
klikając przycisk OK.
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Aktywacja trybu alarmu
Kliknięcie przycisku Activate alarm (Aktywuj alarm) lub wybór
zapisanego filtra z aktywacją alarmu powoduje zamknięcie okna
aplikacji LogViewer (Analiza dziennika) i przejście jej w tryb
oczekiwania. Jest ona wtedy widoczna jako ikona  na pasku
systemowym. Po ustawieniu wskaźnika myszy na tej ikonie
wyświetlany jest tekst Access PE: Wait for alarm (Access PE:
czekaj na alarm). Dwukrotnym kliknięciem ikony można w każdej
chwili ponownie wyświetlić to okno dialogowe na pierwszym
planie.

Uwaga!

Dopóki jest aktywny tryb Alarm mode (Tryb alarmu), aplikacji

nie można zamknąć ani kliknięciem przycisku x na pasku tytułu,

ani za pomocą polecenia File > Exit (Plik > Zakończ). Zamiast

tego aplikacja LogViewer (Analiza dziennika) powraca do trybu

oczekiwania.

W przypadku odebrania komunikatu główne okno jest ponownie
wyświetlane na pierwszym planie.
Jeśli nie jest zaznaczone pole wyboru Sound Off (Dźwięk
wyłączony), pojawieniu się komunikatu towarzyszy dodatkowo
sygnał akustyczny.
 

Raporty: widok strony
Istnieje możliwość ustawiania filtrów ograniczających zawartość
raportu. W przypadku braku filtru raportowane są wszystkie
dane. Przycisk Search (Wyszukaj) umożliwia wyszukanie danych
i ich wyświetlenie w oknie podglądu.

3.3

 

3.4
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Uwaga!

Przed zmianą kryteriów filtrowania należy w pierwszej

kolejności usunąć stare ustawienia za pomocą przycisku Clear

form (Wyczyść formularz), zapobiegając w ten sposób

uzyskaniu błędnych wyników.

Otwarte pliki dziennika można zapisać lub wydrukować. Element

menu File > Print (Plik > Drukuj) lub przycisk  otwiera
podgląd.

 

Uwaga!

Wszystkie otwarte pliki dziennika zostaną wydrukowane.

Należy zamknąć wszystkie pliki, które nie mają być drukowane,

lub ograniczyć wybór do ważnych komunikatów.
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Widok strony raportów zawiera szereg narzędzi do modyfikacji
wyświetlanej zawartości i sposobu jej wyświetlania:

Przycisk Znaczenie Opis

Eksportuj Listę można eksportować do pliku
w celu dalszego przetworzenia.
Dostępne są następujące formaty:
Acrobat Portable Document
Format (PDF)
Wartości oddzielone przecinkiem
(*.CSV)

Drukuj Drukuje raport za pośrednictwem
okna dialogowego wydruku, które
umożliwia ustawienie drukarki
domyślnej.

Wybierz
stronę

Przyciski strzałek umożliwiają
przechodzenie do kolejnej,
ewentualnie pierwszej lub
ostatniej strony raportu.
Wyświetlany jest również numer
strony bieżącej i łączna liczba
stron raportu.

Liczba
stron

Przedstawia stronę bieżącą i
liczbę wszystkich stron.

Powiększ Domyślna skala (100%) może
zostać zmieniona według
potrzeby.

Eksportowanie list
Naciśnięcie przycisku  powoduje otwarcie okna dialogowego
umożliwiającego zdefiniowanie kryteriów eksportu.
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Pole listy wyboru o nazwie Format oferuje formaty
wyjściowe .pdf (do przekazywania i archiwizowania określonych
wyników wyszukiwania) i .csv (do dalszego przetwarzania
danych).
W przypadku eksportowania danych do pliku csv można je do
pewnego stopnia przetworzyć.
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Oprócz wprowadzenia ogranicznika (Delimiter) oraz trybu
(Mode) eksportu, można także wykluczyć lub wyizolować z
eksportu fragmenty raportu i strony (Report and Page sections)
(nagłówki kolumn i szczegóły strony) oraz fragmenty grupy
(Group sections) (wybrane dane).
Jedną z poniższych opcji można wybrać jako Destination
(Miejsce przeznaczenia).
– Application (Aplikacja) — otwiera plik za pomocą

odpowiedniej aplikacji. Ta aplikacja musi być zainstalowana
na komputerze. Pliki pdf są otwierane za pomocą programu
Adobe Acrobat Reader, a pliki csv — za pomocą programu
MS Excel.

– Disk file (Plik dyskowy) (domyślnie) — otwiera okno
dialogowe Eksploratora w celu wybrania żądanego katalogu.
Proponowana jest nazwa do zapisania pliku.

– Exchange folder (Folder programu Exchange) — plik można
wysłać bezpośrednio do odbiorcy w programie MS Outlook.

– Lotus Domino Mail — plik można wysłać bezpośrednio do
odbiorcy w programie Lotus Domino Mail.

 

Odtwarzanie obrazu wideo
Jeśli dla wejścia skonfigurowano kamerę nadzorującą, wszystkie
komunikaty dotyczące tego wejścia będą oznaczone w oknie

dialogowym dziennika ikoną . W zależności od konfiguracji
urządzenia wizyjnego oznacza to, że sekwencje wideo z
wybranej kamery nadzorującej są dostępne i mogą być
odtwarzane, począwszy od chwili wysłania komunikatu.
Wybranie komunikatu związanego z kamerą identyfikacyjną

spowoduje uaktywnienie przycisku  na pasku narzędzi.
Kliknięcie tego przycisku powoduje otwarcie okna dialogowego
Video playback (Odtwarzanie obrazu wideo).

3.5
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Odtwarzanie obrazu wideo
Otwarcie okna dialogowego Video playback (Odtwarzanie
obrazu wideo) inicjuje odtwarzanie, które domyślnie rozpoczyna
się 20 sekund przed wysłaniem alarmu i kończy się 120 sekund
później.
W momencie pojawienia się alarmu można skonfigurować punkt
początkowy i czas trwania sekwencji.
Uwagi na temat obsługi okna dialogowego:

Wskaźnik postępu pokazujący, w którym
miejscu ustawionego okresu znajduje się
obecnie zapis.

Pola, w których można ustawić początek i
koniec okresu wyświetlania sekwencji
wideo.

Czas ustawionego rozpoczęcia i
zakończenia zostanie aktywowany dopiero
po zatwierdzeniu zmian przez naciśnięcie
tego przycisku.
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Po przerwie wywołanej naciśnięciem
przycisku pauzy ponownie uruchamia
sekwencję wideo lub zmniejsza prędkość
odtwarzania, jeśli aktywowany był tryb
szybki.

Tryb szybki – szybko przewija sekwencję
wideo.

Pauza – przerywa wyświetlanie – tworzy
obraz zatrzymany.

Przeskakuje do początku sekwencji i
ponownie uruchamia odtwarzanie.

Przeskakuje do momentu wysłania
komunikatu alarmowego, dla którego
uruchomiony został zapis wideo.
Uwaga: jest to możliwe tylko wtedy, gdy
czas alarmu pokrywa się z ustalonym
przedziałem czasowym.

Służy do zamykania okna dialogowego
Video playback (Odtwarzanie obrazu
wideo).
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Wymagania normy UL 294
Funkcje, które nie zostały ocenione przez firmę UL:
– System weryfikacji wideo
– Przeglądanie map i zarządzanie alarmami z weryfikacją map

i wideo
– Odtwarzacz wideo
– Badge Designer (Projektant identyfikatorów)
– Modele Delta 1200 Series
– Modele Rosslare ARD-1200EM Series
– Kontrolery LAC
– Kontrolery LACi
– Kontrolery APC-AMC2-4R4CF

– Protokół interfejsu czytnika BG 900
– Protokół interfejsu czytnika L-BUS

– System sygnalizacji włamania — uzbrajanie/rozbrajanie
– Używanie windy
– SMS-y
– Dziennik
– Zarządzanie personelem i raporty
– Używanie alarmu włamaniowego

Funkcje ocenione przez firmę UL:
– Czytniki w 26-bitowym formacie Wiegand
– Kontrolery AMC2:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW jako dodatkowy sprzęt monitorujący
Następujące modele czytników kart firmy Bosch zostały
ocenione przez firmę UL pod kątem zgodności z systemem
oprogramowania APE-SW firmy Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI
– LECTUS secure 5000 WI

4
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